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7.PC

Turn On Sequence
(off-reverse order) Nikon

5. Ti-E Microscope
6. Fluorescent

Light Source Right side — switch
on Back

1. Lasers-key
switch
(clockwise)

8. Launch
NIS-Elements

1. Lasers-key
Software

switch
(clockwise)

2. Transmitted
Light Power
Supply

3. C2 Controller-
push button

4. Motorized XY
Stage Controller



Main System Components wikon

Confocal PMTs
(DU3)

Transmitted Light

Power Supply

Confocal C2
Controller

LU-N4
Laser Launch
(405nm, 488nm,
561nm, 640nm)

LUNV Laser
Controller

Motorized XY Stage
Controller



Main System Components wikon

Transmitted Detector

Field Stop
Condenser Stagelggrt'::ri foystlc
Motorized XY Stage

Fluorescence Light
Source Control Pod

C2 Confocal Scan
Head




Main System Components wikon

Fluorescence Filter

Focus knob Cubes Changer

Escape & Refocus
Objectives Changer

Perfect Focus

1X - 1.5X Mag

) Changer
Light Path Changer




Quick Review on Kohler
Alighment

*Use a 10x objective if available and fully open the condenser aperture diaphragm

Nikon

1. Focus on a sample

2. Close down your field stop

3. Focus your condenser (adjust condenser height)

4. Center your condenser

5. Open field aperture
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General Software Statement§ion

As a general reference, the devices connected to the software can be reviewed in the
"Device Manager” under “Devices”. This is a good place to confirm all portions of the
system are connected and working properly.

View Devices Window Applications Help
A 100 [~ | \APLEYES FITCEYES TXRED-EYES MP-Home Al-Home REMOVE NDD DETECTORS RETURN TO CONFOCAL MODE

‘ 1

*On this system, you should see the
Ti Microscope as being connected.

, make sure the device is physically
=% o turned on, then highlight the device
and select “Connect” to reconnect.




Good to know.... Nikon

Most dialogs can be found under the View tab
(,?cquisition/AnaIysis/VisuaIization Controls) in
Elements

-As a shortcut these can also be found by right
clicking in the open space of Elements

Elements obeys most Windows-based functions,
shift/control and Alt are used often; right-clicks are
used to display options/properties

Elements also uses “drag and drop” for overlaying
windows/datasets

ND2 Files can be opened/viewed outside of Elements
with a free download on WWW.Nis-
elements.com. There is also a plugin for Imagel.
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System Information  wikon

System Information x

%

NIS elements time 0:03:46

System Information x

¥
NIS elements time 0:51:58

*The system information will tell you how long
the software has been running for that
session and will also tell you what direction

you are focusing.

System Information x

T

NIS elements time 0:52:33
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Microscope Control  wikon

TiPad =

Nosepiece

Light Path « The Ti Microscope Pad allows to:

E100

€
® O

(80 « Select light path

Z Drrive

« Switch between objectives

Move by step[um]:

« Use Perfect Focus
« Change Filters

Lamps

Filters
Turretl “ : H F ':

Condenser
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LUTS and Histogram  wikon.

The LUTs menu can be used
for brightness/contrast
adjustment (using triangular
sliders) as well as for
| showing a saturation
2000 | 3000 | 4000 indicator L= which can be

T used to show what pixels are
=¥ saturated. Use the drop
| down arrow to select
e “‘complementary color”

TR}
Hold Shift key to control all channels

I
1000 2000

Km'-.x'

The traditional Histogram
gives similar information
as the LUTs but is very
useful in determining a
confocal “offset”
adjustment
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ND Experiments Nikon

- “““"““"'11 "t *Experiments can be run on time,
Experiment: MDD Acquisition . .
F Z-stacks, wavelength switching or
stage positions and image

A I

[ Save toFie .___ stitching (if a motorized stage is
— supplied).

Path: C:\Program Files\NIS-Elements\Images)
Filename: nd002.nd2 Record Data...
Order of Experiment b

o [ % 2 5eries [ & Lambda -The next few slides will explain
s *  Fa b Ne each dimension.

or
Optical Conf, Mame Comp. Color
[v] 405-488-561nm  ~ DAPI
FITC _
Texas Red |V |
[l 540nm + Cy5 .

@

Advanced ==

=3 = el
&8 Run Z Corr % Run now
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Time Lapse Nikon

e == °* To add a timelapse, check off the
| 352 XY Pos | ZSeries | | ambda | | » Large Image ] ’
_ . - W ] checkbox for “Time”.
+ ga L K

e T e e« Add a time phase by checking one
e ol box; you can change the interval (how
often to image) and the duration (total
time). Alternatively you can input a

number of loops (# of images required).

* v|Close Active Shutter when Idle | Perform Time Measurement (0 ROIs)
| Use Ratio | Define Ratio... ﬁ:% B .
[Events... | Advanced >> * You can add additional time phases to

be run in sequence.

» The “X” will reset the time phases.
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Z-Stacking/Optical Sectioningon

There are three methods for optical sectioning .select one

1. Choose a middle plane and click “reset”, go to a live view
and focus towards the bottom (click bottom) then focus to
top (click top)

*Set your step size (distance between each plane) and/or
the # of steps you want (image total)

2. Choose a middle plane and click “home” then input a
distance range (equal from top to bottom)

3. Choose a plane somewhere in the sample and click
“‘home” then input a staggered range above and below

16



ND Acguisition =
Experiment: MND Acquisition

7 I N
e [

[+] save to File

Nikon

Lambda-wavelength

Path: C:\Program Files\NIS-Elements \Images),

Filename: nd002.nd2

Order of Experiment

[0 4%

Setup

Dptical Conf,

[+] 405-488-56 1nm -

'___ 540nm i

¥ & zse

Mame
AP
FITC
Texas Red

Cy5

= [{: ."‘ Lambda

* & a

Comp. Color

G2 -
=g Run £ Corr

Browse...

Record Data. ..

Advanced ==

e
=5 Run now

* You can add automated wavelength
switching to an experiment by checking
off the checkbox for “Lambda”.

*You can add an optical configuration, if
one was created, by clicking on the
down arrows

*Make sure to adjust your confocal scan
settings before adding
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Confocal Imaging: C2+ wikon

18



[ NIS-Elerments AR | = x|
Edt  Acquire

‘I‘

Manual Microscope Pad x Caplus Simple GUIT x

Nosepiece
10x 40

F

Filter Turret

C2plus Scan Area x

[¥] TexasRed Laser S61.0nm 0.0
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Using Optical Configurationsion

415-338-501nm o40nm 405-4858-568 Inm with TD

*You may have a series of “shortcut” keys on the top toolbar for confocal imaging and
control of the microscope with a single button. These are referred to as “optical
configurations”.

Click on the confiquration you want to use

On your system, click on:
405-488-561nm: this will use all three lasers/PMTs
640nm: this will use the 640 laser/PMT

405-488-561nm with TD: this will use all three lasers/PMTs and also insert the TD
(transmission detector)

Note: Please remove the transmission detector if returning to the eyepieces to view a
sample. The transmission detector is very sensitive to light and can be damaged if
fluorescence or transmitted light is used instead of confocal!

20



Confocal Acquisition: Quick Start

*The C2plus Simple GUI is a wizard that will Nikon N
walk you through acquiring a confocal
> & image

Scan Capture

C2plus Simple GUT =

1. Make sure you have previewed your slide through the eyepieces
and focused on an area of interest.

2. Select the objective that you’re using in the manual microscope pad
Click on an optical configuration on the top toolbar to get started

4, Select what laser lines you want to acquire (check boxes for
DAPI/FITC/TXRED/TD (transmission) or CY5

. HV-Gain, start at 100
. Offset-background adjustment, start at 0
. Laser Power, start at 5%
Start with a scan size of 512x512 and scan speed of 1.9usec.
Select “Normal” and “Ch Series”
Select 1.2 AU for Pinhole
Start “SCAN”
Adjust if needed
0. Click “CAPTURE”

o © © N o oo

*To save, click on File>Save As and select either a .tif (keeping bit depth)
or .jp2 for raw data, NOT a JPG.
*To convert into a viewable image, save an
additional copy as a converted tiff (shown

below)
File name: [Cap{ured E]] [ Save ]
Save as type: [Tagged Image Format (*tif: " tiff) E]I [ Cancel ]
TIF Compatibility Options

) Keep bit depth Save Color Image

) Scale 12 bit to 16 bit [T save Binary Image

%) Scale 12 bit to 8 bit [[] save Annotations

Convert multichannel images to RGE 2 1




The C2plus GUI-further explained (top to bottom)

1) Stops/Starts Live Image Acquisition (as a default, please do not use any averaging or

integrating in this mode, see #9) Caplus Simple GUI x
2) Capture: captures an image (using user defined settings below)
3) “Find Mode”: Implements a fast preview scan

a) Defined by Find Mode Settings in 5 Setﬁngs,l

B _. |

[V Change to band scan with aspect:
Gx Ca &

[ Lower resolution:
F2x a8

[¥ Line skipping:
Gx Clax  C8x

[V Turn OFF line&frame averaging

[~ Change Galvano to Resonant

|
4) Eye Port-changes to last used non-confocal setting, click again to return to confocal
mode (N/A on this microscope)

5) AG: Auto Gain feature; sets the HV (gain) for optimum based on user settings (for more
info see Help Menu, 4.2.5 in software)

6) Unidirectional/Bidirectional: scan direction (Uni-one direction, traditional scanning; Bi- Laser 488.0rm 0.0
directional, used for live imaging for speed increase—does need to be aligned during 7
scan). See Help, 8.1.3 for more info.

7) Pixel Dwell/Frame per Sec: scan speed; pixel dwell in micro seconds
8) Size: Scan Size in XY
9) Averaging @ and Integrating 2 average signal by line or integrate signal by line

(see Help, 8.1.4). Normal mode does not use either. Typically averaging is used only for
image capture, not for live preview.

10) Ch Series: Channel Series; setup will allow for each laser to be run sequentially rather
than simultaneously *important for closely excited fluorophores! See Help, 4.1.4

11) Pinhole: adjusts size of pinhole, 1.2 AU can be set via button as standard, see Help 4.2.3
for more information.

12) Optical Path Settings: to set up lasers, dichroics, filters; for experienced users only!

13) Laser Selections: check off laser lines to be used. HV is your amplification gain (100 is a ..m-‘_‘. =1 i [ % WD
good starting point), offset will black values (0 is a good starting point) and the e
wavelength shown last is your laser power in % (5 is a good starting point).

Note: Offset Adjustment

Offset values should be close to a number value of 0 (zero) but a histogram should be
previewed to adjust this value accurately. The left side of each wavelength’s peak should be
close to 0,0 (bottom left of histogram). A more positive # will move the peak to the right, a
more negative # will move it to the left. Please ask for assistance if you need help—this step is
VERY important!

Lt B DL B )

\




Al Scan Area x
B = — —- Cop e BN OB

Pixel size:  0.62
Scan size: 512 |v
Width: 512
Dwell time: 4.5 s

Pixel size: 0.62 pm
Z step size: 111 um

Al Scan Area x

Nyquist XY |+
Rotation: 0

Height: 512

Optical resolution: 0. 16 pm
Optical sectioning: 1.11pm

B = ——- Cop =<

R-Click to co

Zoom:

Pixel size:  0.25

Scansize: 512 ¥

Width: 212

Dwell time: 4.6 ps

Pixel size: 0.25 pm
Zstep size: 1.11pm

nfirm new scan area

NyquistXY |~
Rotation: 0

Height: 512

Optical resolution: 0.16 ym
Optical sectioning: 1.11pm

Scan Area/Zoom/
Resolution Improvements

Nikon

» Locate the “C2 Scan Area”
dialog (View—>Acquisition
Controls>C2 Scan Area)

. Captured RETURN TO CONFOCAL MODE 2 L L]

* You can click and drag the g e IS EXxE-B-[%a RS aQm: -

B e — —- Woe ®oex. HE B

green borders of the image to o g:

zoom into an area of interest.
While zooming in normally
decreases resolution, it can .
increase resolution when using a [Sai S ——.
confocal. The pixel size will
decrease and keep the image
size the same.

*The “Nyquist XY” button will
select the appropriate settings to
set the selected area at Nyquist
resolution (based on preferences
set with drop down arrow). 23



Nikon

Post Acquisition
Image Adjustments

24



Scale Bars

Nikon

B QR oo
A Scale Bar can be added at any
time from the right side image
window’s toolbar. Once positioned
where you choose, you can right
click on it to change its properties
or to “burn it” into the image

*it is recommended to save an
original image before burning a
scalebar into an image, save the
second as a copy

EJ.‘
r-
+ -
r’a-
=B
o -
-
A-
!A

L {
\All/ TXRED MID  031ym/px | 212bk: 512x 512 pixels N/A)
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058 10 g2 0 D 19500
T O T
e e e e e ] DY

s 2 500 v

Projection
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*Can also make really nice 3D rotational movies as .avi's!



Movie Maker

Nikon

DAnkasQECUUG.ndE - Volume
W g N X A~ (- @ 2= B8 0P Ve EOFe W - | @ |
Z-zoom ~ | Blending: Max ~ | =] 'HT’J_— :@Bounding box {on bottom) ~ § "_| ',Z g, W |G

View -

% | A 2t PR
ks |'i‘..' S T e

SRS L-IE

0:30  0:40 0:50  1:00 1:0 120 130 1:50  2:00  1:10  2:20
o wlovnininen ..I....|....I....|“.|....I....|....I....|..‘.I....|..‘.

Z:I)Z) 2:40
alinm

2:
Lo '

—

Click the film icon to open movie maker

—

Make rotations/movements/adjustments
and click where you want them to show
up in the filmstrip. Once you play it
back and it looks good, click on the film
icon to create an .avi.

File name: |AnkasQ2CDDE j Save |
Save as type: |A\.f| Image File Format (~avi) ﬂ Cancel |
[ Use Default Video Compression i
o 0 compression
|N0 compression / -
QOutput Timing Parameters Experiment Loop
- Tl
™ Use Original Acq.Time eslbus iy
- ¢ Use Z-stack Loop
[ RSy 200 ms " Use Z-stack and Time Loop

About 150-200ms

Z¥|
y ANl /B DAPL ) W FITC /(31 2hit: 102

ixels

lick film strip (black to red) to g

is usually good

o into editing mode 27



“X" Key Snapshots  wikon

o RAml™Q Q2 *Use the “x” key on your

keyboard to take snapshots
for publication/presentation

,, F i 3 1 -can be used on any open
< \RGE/ Red WGmen Bue  019um/im | RGO B 1079% 367 picds A image WindOVV, in any
EF""”J'b RXHE-u- M4EEGR REa e . Of'lentatlon

s
B Hsm — - W & ck. B @
|

“Split Window”

0
-
3.
8
&
-
%.
it -
A_
"'
8
E-

Jopm
\NAN/ TXRED WID 013 m/px _2(1231:512x5'|2puels [N/A) ol 28

:nc.n / Red W Green Biue
0.23 pm/px RGB 8bit: 290 x 902 pixels [N/A]



Magnifying Glass Nikon_

[ Nis-Elements AR - [View Snapshot:

Acquire Calibration Image Binary Measure Reference Macro View Devices Window Applications Help

« The magnifying glass can

y . ° Q '@ @ @cr @DA| i) 'O 7 DAPLEYES FITCEYES TXRED-EYES MP-Home A
X

= m View Snapshot*

, L
IR m -

Light Path
E100 ® Foaus  Offset:

. 1979

On

Memory Recal

® Coarse Accuracy:
; ® Fine 0.0000 |¥ | [um]
® Extra Fine

Lamps
DIA

Shutters

@ @on

Filters

et R S [ow
nalyzer

Condenser

B

L

% ZD
p
Eﬁ 2996.1
"

o

B

E

o

5DICN2

l’ System Information x

/" Red W Green

Blue
* =3 2 pm/px RGB 8bit: 533 x 533 pixels

be used to show zoomed
portions of an image

« Under View->Magnifying
glass options, you can change
the zoom and shape/border

*Holding down “shift” after
choosing an area can allow it
to be moved to another spot
on the image; click on “X” to
take a snapshot (as shown
here)
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